
 
 
 
 

 

 

 
 
 

MACNET 
DATABASE 

UTILITY 
 

USER MANUAL 

 
2300, Leon-Harmel, suite 220 
Quebec (Quebec) G1N 4L2 
 
(418) 682-3380 
(418) 682-8996 

 

 

MANUSEDB-E 
Version 4.0 
First Edition 

December 18, 2003 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Copyright © 2003, by Comlab inc. 
 
All rights of translation, adaptation and reproduction by any means reserved for all countries.  
The contents of this manual may not be reproduced or transmitted in any form, in whole or in 
part, without written permission from Comlab. 



 
 

MacNet Database Utility 
User Manual 

 
 

 
December 18, 2003 Version 3.0 i 

 

 
 
 TABLE OF CONTENTS 
 
 
 

1 INTRODUCTION.................................................................................................................1 

2 HOW TO START THE PROGRAM.....................................................................................2 

3 HOW TO PERFORM A BACKUP.......................................................................................5 

4 HOW TO PERFORM A RESTORE.....................................................................................7 

5 HOW TO EXIT THE PROGRAM PROPERLY ..................................................................11 

6 GENERAL RECOMMENDATION.....................................................................................11 

7 OTHER INFORMATION....................................................................................................11 



 
 

MacNet Database Utility 
User Manual 

 
 

 
December 18, 2003 Version 3.0 1 

 

1 INTRODUCTION 
 
MacNet Database Utility is a companion Utility (software) that can only be used in the context of a MacNet 
installation.  MacNet is the software sold by Comlab as a management tool for multi-site implementation of 
the MAC System and / or MiniMAC System.  
 
MacNet Database Utility is designed only to perform tasks related to that context.  It cannot be used as a 
generic BACKUP and RESTORE tool. 
 
 
The platforms required to run the software are: Windows 9x or NT Technology.  
 
 
The only computer setting you should check is the display.  Even if all the dialog boxes and displays are 
relatively small, the display must be configured with a screen of 800 x 600, like MacNet. 
  
 
Even though you will find in this manual all of MacNet’s dialog boxes and displays and related to use of 
MacNet Database Utility, this is not a MacNet manual.  Throughout the MacNet development, those 
dialog boxes and displays may be updated.  This is why you should refer to the manual corresponding to 
the version of MacNet you are currently using for more appropriate information. 
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2 HOW TO START THE PROGRAM 
 
There are two ways to activate the software: as standalone software or from MacNet.  
 
 
The first way is to directly run the mndbutil.exe file, either from Windows Explorer or using the Windows 
Start button Run option.  
 
IMPORTANT: If MacNet is running while you perform a Backup or a Restore using MacNet Database 
Utility in standalone mode, certain files that remained open will not be properly handled if they are not 
closed. 
 
The Main Screen is displayed as shown in Figure 2-1.  A notice, located at the bottom left of the Main 
Screen, prompts you to select the File drop-down menu to activate the tools window. Then, the MacNet 
Database Utility dialog box is displayed. 
 
 

 
Figure 2-1: MacNet Database Utility Main Screen. 

 
 
If you run MacNet Database Utility as standalone software, none of the previous operations need to be 
performed.  You only need to make sure that MacNet IS NOT RUNNING before launching MacNet 
Database Utility. 
 
The second way to launch MacNet Database Utility is to start it from the MacNet (version 3.0 or higher)  
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Map Screen Options drop-down menu.  
 
From the Options drop-down menu, select Database to activate the Database dialog box, as shown in 
Figure 2-2.  Then, click the MacNet Database Utility button to launch the software. 
 
MacNet automatically provides the proper language parameter (if MacNet is currently displayed in English, so 
will MacNet Database Utility).  
 
 

 
Figure 2-2: Database dialog box. 

 
 
When MacNet is running, some files related to the Alarm Reception process and the refreshing of the 
Map Screen, are opened.  Clicking on the MacNet Database Utility button closes MacNet and stops the 
Alarm Reception process. The following dialog box is displayed on the screen. 
 

 
Figure 2-3: Alarm reception interruption and MacNet shutdown. 

 
Answering YES confirms that you realy want to stop the Alarm Reception process, close MacNet and start 
MacNet Database Utility. 
 
Answering NO does not affect the Alarm Reception process or MacNet Map Screen.  The system simply 
returns to the Database dialog box. 
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Before a Backup can be performed, the data in the MacNetLog table must be transferred in Archived 
MacNetLog.  If you activate the software to perform a Backup, you need to transfer this data first.  As 
shown in Figure 2-4, MacNet asks to confirm if a Backup is to be performed.   
 
 

 
Figure 2-4: Archive MacNet History Log confirmation. 

 
 
Answering YES transfers data from MacNetLog to Archived MacNetLog before launching Macnet 
Database Utility.   
 
Answering NO will immediately launch Macnet Database Utility. 
 
The MacNet Database Utility is displayed as shown in Figure 2-5.  MacNet is closed.  If an Alarm Call 
should occur at this point, nothing would happen since the Alarm Reception process as also been 
terminated. 
 
 

 
Figure 2-5: MacNet Database Utility dialog box. 

 
 
 
You can use MacNet Database Utility from a MacNet version prior to version 3.0.  In this case, CLOSE 
MacNet BEFORE running MacNet Database Utility. 
 
 
MacNet Database Utility should be launched in standalone mode only when MacNet IS NOT RUNNING. 
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3 HOW TO PERFORM A BACKUP 
 
This operation consists of compressing all files found in the Database sub-folder to a compressed file 
called MacNet Backup File.  The MacNet Backup Files are always stored in the sub-folder Backup.  The 
observed compression ratio is about 30% of the file’s original size. 
 
When performing a Backup, the software will automatically generate a file name using the current date and 
time, for a UNIQUE identifier, in the format “YYYYMMDD-HHMMSS.MBF”.  Only MacNet related data are 
saved. The software is not saved.   
 
 

 
Figure 3-1: MacNet Database Utility dialog box. 

 
 
From the MacNet Database Utility dialog box shown in Figure 3-1, click on the “Backup” button. The 
message shown in Figure 3-2 will be displayed to indicate the file name and ask you to confirm the 
“Backup“ operation. 
 
 

 
Figure 3-2: Confirm Backup operation. 
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Answering Yes initiates the Backup operation. The compression process of all data related to MacNet 
begins.  During the Backup operation, the list of all compressed files is shown at the bottom of the dialog 
box, as shown in Figure 3-3.  This may take a few minutes. 
 
Answering No cancels the Backup operation and only returns you to the MacNet Database Utility dialog 
box without any changes. 
 
 

 
Figure 3-3: File being compressed. 

 
 
The duration of the compression process depends on the amount of data requiring compression.  A red 
indicator, at the bottom right of the MacNet Database Utility dialog box, rotateS to indicate that 
compression is underway.  When the compression process is completed, a status message will be 
displayed, as shown in Figure 3-4. 
 
 

 
Figure 3-4: “Backup“ completed. 

 
 
The new MacNet Backup File created during the Backup operation is now located in the Backup 
sub-folder.   
 
When the Backup operation is completed, click OK to return to the MacNet Database Utility dialog box. 
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4 HOW TO PERFORM A RESTORE 
 
This operation consists of restoring all data found in the Database sub-folder at the time of the Backup 
operation.  The restore operation replaces the data located in the Database sub-folder. 
 
During the Restore operation, the software automatically renames the Database sub-folder as 
Database~TMP.  If the Database~TMP sub-folder already exists, make sure to rename it before 
performing the Restore operation otherwise the new sub-folder will replace the old one.  You can also 
choose a different destination folder, but make sure the chosen folder is empty. 
 
 

 
Figure 4-1: MacNet Database Utility dialog box. 

 
 
From the MacNet Database Utility dialog box shown in Figure 4-1, click on the Restore button.  The 
standard Open dialog box will appear, as shown in Figure 4-2.  Select the “. MBF“ file to restore from the 
sub-folder, and click OPEN to continue.  
 
 

 
Figure 4-2: Choose the MacNet Backup File to restore. 
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The Restore operation is primarly designed to accomodate the standard MacNet installation.  This is why 
MacNet Database Utility will check your disk for the normal data structure. 
 

 
Figure 4-3: Locating Database sub-folder. 

 
 
If the Database sub-folder is not found, you will be asked to recreate it as shown in Figure 4-4.   
 
 

 
Figure 4-4: Database sub-folder creation confirmation. 

 
 
If you do not intend to run MacNet on this computer, you can choose to recreate the Database sub-folder 
on a different computer.  Answering either Yes or No will not interrumpt the RESTORE operation. 
 
 
The next step is the selection of the destination folder.  Once again, the MacNet normal data structure is 
applied. The default folder the software will propose is “C:\MacNet\Database”, if it exists.  Figure 4-5 shows 
the standard Save as dialog box from whitch you need to either confirm the current folder or choose 
another destination folder”.   
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Figure 4-5 : Select a destination folder from the Save as dialog box. 

 
 
Finaly, you will need to confirm the information as shown in Figure 4-6 to begin the Restore operation. 

 

 
Figure 4-6: Confirm the file to be restored and the destination folder. 

 
 
Answering Yes initiates restoration. 
 
Answering No will only return you to the MacNet Database Utility dialog box without any changes. 
 
 

 
Figure 4-7: What file is being restored. 
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During the Restore operation, the name of each compressed file is shown in turn at the bottom of the 
dialog box, as shown in Figure 4-7.  A red indicator at the bottom right of the dialog box rotates while 
decompressing data. The duration of this process depends on the amount of data to be restored. When the 
Restore operation is completed, a status message is displayed, as shown in Figure 4-8. 
 
 

 
Figure 4-8: Restore operation completed. 

 
Figure 4-9 shows the message displayed before completely ending the Restore operation.   
 
 

 
Figure 4-9: Confirmation of old data location. 

 
 
In this example, files have been restored in the folder “C:\My Documents\My Archives”.  Data previously 
contained in that folder have been moved to the “C:\My Documents\My Archives~TMP” folder.  MacNet 
Database Utility confirms the end of the Restore operation.  If any error occured during the Restore 
operation, you will find the previous data in the “C:\My Documents\My Archives~TMP” folder. 
 
 
Once you click on OK, you will return to the MacNet Database Utility dialog box.   
 
 
The restored database files can be used with MacNet or with other software.  
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5 HOW TO EXIT THE PROGRAM PROPERLY 
 
If MacNet Database Utility is used as standalone software, just click Return to return to the Main Screen. 
Choose Quit from the File menu or click on the X located in the upper right corner of the Main Screen. 
 
 
If you are running MacNet Database Utility from MacNet, click Return to restart MacNet automatically. 
 
 
6 GENERAL RECOMMENDATION 
 
It is recommended to Restart the computer periodically to avoid problems.  This will free the memory and 
empty the system’s buffers used by MacNet, especially if it has been running without interruption for a long 
period of time. 
 
Before restarting MacNet, you could also take the time to do maintenance on your hard drive such as 
performing a Scandisk and Defragmentation.  Use the Windows system tools to do this. Then restart the 
computer again to let MacNet restart a new session in a clean environment. 
 
 
7 OTHER INFORMATION 
 
This version of the MacNet Database Utility does not include a Help module since its operation is straight 
forward and this manual answer all related questions. 
 
 
Remember that the software is to be used primarly with MacNet. 
 
 
Remember that MacNet Database Utility is only a tool to assist the normal maintenance of MacNet. 
 


